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E10363-130501 Profil Manager

1. INTRODUCTION

1.1 PROFIL MANAGER SOFTWARE

Profil Manager is a utility program supplied with the Roctest Profil inclinometer system. The Profil Manager program

can:

Create inclinometer databases.

Import inclinometer surveys.

Display, print, and export simple inclinometer plots.
Generate QR codes for use as inclinometer IDs.

1.2 SYSTEM WORKFLOW

1.

2.

3.

The Roctest Profil probe, reel, and reader are used to survey inclinometers. Survey readings are saved to
inclinometer data files.

Profil’
(o}

¥ o 3
e o .

ROCIEST

The Profil reader sends borehole data files to a PC, which stores the files in an import folder.

ROCIEST MDA,



E10363-130501 Profil Manager

4. Profil Manager displays and prints inclinometer plots.

2. CREATE A DATABASE
2.1 OVERVIEW

Profil Manager Program creates a database to keep inclinometer surveys neatly indexed by inclinometer name and
survey date.

2.2 INSTALLING PROFIL MANAGER

1. Direct your browser to www.roctest.com.
2. Click Support - Download — Roctest Profil Manager.
3. Run the “Profil_manager _setup.exe” program after it downloads.

2.3 CREATING A DATABASE
1. Start Profil Manager, then click File - New.

2. Enter a name for the database.
3. Click Save.

rcinomezer database

Save s type: DigPro 2 Fies ("dow)

Notes:
e The default folder for the database is “My Documents” in Windows XP or “Documents” in Windows 7 and 8.
You can choose a different default folder: click Edit - Preferences - Database Folder.
¢ In this example, the database file is named “inclinometer-database.” You can choose a different filename.
e The database file has a .dpw extension and is compatible with Profil Manager and DigiPro 2.

ROCIEST MDA,
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3. DUX FILE TRANSFERS

3.1 OVERVIEW

If the internet is available, the Reader can send dux files to the PC by email or Dropbox. Internet transfers are
convenient and partially automated. If the internet is not available, you can use the Windows file manager and a
USB cable to copy files from the Reader to the PC.

3.2 EMAIL TRANSFERS

The Reader sends dux files as attachments to an email message.

1. Open the email message with Outlook, Gmail, or some other email client.
2. Save the dux files attachments into the import folder.

@Hﬁ‘f.*xi‘_@)({}é s FW: Calit|
] tew Mait Message S At St |
Save As
LN, Save a copy of the item to your computer in
0, Save Attachments &
| B Save one or more of the files attached to I
| M Sove s y this message to your computer.
x Delete @ Convert to Adobe PDF
2> pove >
A
U e
= Properties 1
N
Close

3.3 DROPBOX TRANSFERS

Dropbox transfers are more automated than email transfers. No user actions are required. The dux files sent from
the Reader simply appear in the import folder on your PC.

Reader is linked to PCis linked to
Dropbox account Dropbox account

The convenience of Dropbox is well worth the time that it takes to set up. Other cloud services such as Google Drive
can be set up in a similar way.

ROCIEST MDA,
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1. Visit Dropbox.com using your web browser. Create a free Dropbox account. Enter an email address for the User
ID, then create a Dropbox password. User ID and password are used again in the next steps

2. Download Dropbox for Windows. Run the setup program and then log in to Dropbox, using your User ID and
password. Now your PC is linked to Dropbox in the cloud.

3. Start RPM and create a default import folder in Dropbox, as explained in the previous chapter.

4. Visit the Google Play store using your Android device. Search for Drop-box and install it. You already have a
Dropbox account, so login using your User ID and password. Now the Android device is linked to Drop-box, too.

5. The Dropbox file listing on your Android device now shows the default import folder. That is where the Reader
app will send dux files.

3.4 USB TRANSFERS

Use the Windows file manager and the USB cable supplied with your Android device. No USB drivers are required.

1. Connect the Reader to the PC using the USB cable.
Switch on the Reader.
A dialog appears on your PC. Choose “Open device ...”

Portable Device x|

/@) Windows can perform the same action each time you
,_\4 connect this device.

What do you want Windows to do?

@ Sync digital media files to this device
1sing Windows Media Player

Q Take no action

™ Always perfor the selected action

[oxp] comce |

2. Windows opens the device. Click on “Internal storage.”

| Fle Edt View Favorites Tooks Hep | &
J OB&:I. - Q - l"_’ ‘;) Search - Folders W P x »
]Add’eml o). My ComputerTransformer Prime TF201 j Go
Name = IType IToHSize Free|

w Generic hierarchical 27.6GE 2]

< |

1 objects selected

ROCIEST MDA,
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3. Windows displays list of folders. Click on the “Profil Reader” folder.

“= My Computer\Transformer Prime 'J'FZOI\III!G‘I‘I-I g

| Fie Edit Yiew Favorites TJools Hep
0 T &

Qe - @ - (B Pseat [yroes | [
| Address |"v' My Computer \Transformer Prim= TF20 1\Internal storag:
Name ~ I Typa
£ .astro Fie Falder
LAlarms File Folder
(2 Android Fie Folder
CHDCIM File Fald=r

Flie Foldar
) Dozuments Fike Foldar
() Download File Fald=r
< |

4. Click on the Outbox folder. This folder holds the dux files that should be transferred.

_ My Computer\Transformer Prime TF201\Inte: stor: - Ulﬂ
| Fle Edt view Favorites Tools Help a

J@B‘*'Q' % | JO search -L___Folders|_'$i X ».

J Address |u My Computer {Transformer Prime TF201\[Internal storageD\gi':] Go

Name ~ | Type | size | Tra
I Indinometer Data File Folder

File Folder
< | |

5. Select all the dux files in the Outbox, then right-click, and choose Copy.

- i
J@aadcv{ ) - (T | JOseach [ roders | [ (B X 7
J Address I@ My Computer {Transformer Prime TF201\Internal storage‘n,Digi'j Go

[ Type | sie|Tra

DUX File 83.53KB

DUX File 7.12KB

DUX File 7.12KB

DUX File 7.12KB

DUX File 8.53KB
| »
H Copies the selected items to the Clipboard. To put them in the new location, use theF

6. Now paste the dux files into the default import folder.
J@M'\)' :’|/:jseaﬂ:h n Folderg| B XK)H

]Addresﬂ Iu:) C:\Documents and SettingsY Wy Documents\dux-mport
[ [ size | Type
View »
Arrange Icons By »
Refresh

ROCIEST MDA,
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4. CREATE AN IMPORT FOLDER

4.1 OVERVIEW

Profil Manager

The Profil Reader sends inclinometer data files to the PC. This chapter tells how to create an import folder to hold

the files.

4.2 DUX FILES

Roctest Profil inclinometer data files have a .dux extension.

4.3 CREATING THE IMPORT FOLDER

1. Start Profil Manager. Open the database that you just created. Import Folder

Fie Edit Vew Plot

col: Dkt AT Windows  Help

Loskcin: [ () My Docurments

ENGE e

2l x|

U

3

Iy Computer

Flacea

-
My Network  [EELELES
Filaa of type:

Sumpart

Encinome ier-tstabese, dow

Indr\o'ne’.e'dad:laas.-:uw

Led Le

|DaiPro 2 Fies " dow)

Opsn
Cancel

2. Click Roctest Profil - Default Import Folder.

155

8 File FEdit View Plot Tools

Profil Reader | Windows  Help

C:\Users\Public\Documerts\Inclinometer d|

Impert Su

Select Inclinometers to Export  »
ExportIncl

Default Reader Import folder [P

Defautt Reader Export folder

mmary,

£0 Direction

Data Display Urits
Depth Urits:

Top Depth

Bottom Depthr
Depth Interval
Instrumert Constant

Casing Sickup
Oriertation Corrction
Lattude

Longtude:

Elevation:

Edit

] [ dd incinometer | [

Add Survey.

4.4 CREATE IN MY DOCUMENTS

1. Click “My Documents” (XP) or “Documents” (Win 7 & 8).
2. Click “Make New Folder,” enter a name for the folder, and click OK. In the example below, the folder is
named “dux-import,” but you can choose your own name.

ROCIEST

Page 9
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- C:\Documents and Settings\ s \My Documents\inclinometer-database.dpw =10 x|
C:\Documents and Setings' s \My Docume | Inclvometer | Survey Lst |
21|
DU et tercaon 21
DUX Import folder location
2} Desktop
® ) My n%
e & 1§ My Computer 22 -l
) % My Network Place: 20
# Recyde Bin =
(=]
[
=
=]
C
Make New Folder I ;‘
——————— [ WakeNewFoider | oK |\| Cancel |
il VA
1 [ | L]

4.5 OR CREATE IN DROPBOX
Dropbox appears as a folder within My Documents, so create the import folder within Dropbox:

1. Click My Documents.

2. Click the Dropbox Folder.

3. Click “Make New Folder,” enter a name for the folder, and click OK. In the example, the folder is named
“dux-import,” but you can choose your own name.

T —— e A =10] x|
C\Documents and Seftrgs s My Docume_  Incinometer | Survey Lt |
U por e ocation 21
DUX Import folder location
T 21
& 'f My Computer Q I?gskmp DUX Import folder location
@ & My Network Places | & & '39“”"‘3“‘5
# Recyde Bin
. 20 BB oo B
o
= 8 =93 J
i 1%
o ] dux-mport
o ]
&
(i
Make New Folder [ A
Make New Folder
E
Make New Foider[\| oK | cancel |
| | |

5. IMPORT SURVEYS

5.1 OVERVIEW

The instructions below assume that you have a database and some dux files in the import folder.
5.2 IMPORTING SURVEYS

1. Open the database.

ROCIEST Page 10 MDA,
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File Edit View Plot Tools ProfilReader Windows Help
21|
Lod('n:lUMyDoeunems ;] O L
[ndnometerdad)sse dpw 3 Open
[DigiPro 2 Fies (“dpw) =l Concel |
P |
2. Click Profil - Import Surveys. Profil Reader opens the default import folder.
ol File Edit View Plet Tools | Profil Reader | Windows Help -5 X
C.\MMW:MJ Impart Surveys
iy
)
Default Reader Export folder
AO Dirsction:
Data Dispiay Units: Casing Stickup:
Depth Units: Orertation Comection:
Top Depth: Lattude:
Bottom Depth: Longlude
Depth Interval: Bevation:
Instrument Constart.
Edt Add Incinameter Add Survey

3. Select the dux files that you want to import (Ctrl-A for All).
4. Click Open.

I3 e N A e

2x

Lookin: | ) duximport

I"SR15—|N4 dux” "Mukilteo-5.dux" "SR18—|N2dﬂ " OPHIQ
| Cancel
g

[DUX Fies ()

5. Click “Yes” to allow Profil Manager to delete dux files that are imported successfully. These are no longer
needed.

The Reader keeps the original files and the database has the transferred readings.

Import Folder Manageme: 5'

Clean folder after import?
=L@ |
- Page 11 NOVA
ROCIEST h METRIX
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6. Profil Manager imports the surveys and cleans the imported files from the folder.

- My Docume.  Inclnometer Detals | Survey
(3 Mukiteo:INS
@- SR18IN2
@ SR1BING Q —
() o =
Description: ]
A0 Drection: |
Top Depth- I Oriertation Coection: |
Bottom Depth: [ Lattude: [
Degth interval- [ Longtude: [
Instrument Constant: I Bevation |
£t | Addiciometer | Addsover |
| | |

6. INSPECT SURVEYS

6.1 INCLINOMETER DETAILS

Profil Manager

Inclinometers appear on the left. Double-click an inclinometer to see its details on the right. You can also see survey

dates.

¥ C:\Documents and Settings\, \My Documents\inciinometer-database.dpw =10 x|

) C:\Documents and Settings s \My Docum Incle Deas | |
T Digtik: 2012-10-11 10:34:55
Digtit: 2012-10-18 11:24:13
Digtit: 2012-10-25 11:01:17 Ste |
Digtit; 20121101 13:58:10 : T
Digtit: 20121108 16:11:46
& SR1ZIN2 Descrption: [Fikites Fomy Dock
@ SR1ZING e :
Depth Units [Metes Cong 5 —
Top Depth: [o5 Orertation Comectin: [0
Batiom Degth | attuds —
Depth Interval: ﬁ_s — Longhude '0—
Instrument Constant: ||noooo Bevat |°—
£ Addincleometer | AddSuvey |
K [ — | »l

6.2 SURVEY SUMMARY

Click the survey summary tab to see basic survey parameters.

ROCIEST

B C:\Documents and Settings\, \My Documents\indiinometer-database.dpw =10[x|
= C:\Documents and Settings'swwus \My Docum¢ inclnometer Detals | Survey
& Mukiteo:IN5
Ditit: 2012-10-11 10.3455 DsteardTme  |Posmses | Degths | Sensosh | E5uTent Operator | &
Digtit: 2012-10-18 11:26:13
Digtit: 2012:10:25 11:01:17 i 2 5% 12345 100000 e Digt
Digtit: 2012-11-01 13:58:10 20121018 11:28 AM |2 56 12345 100000 peg Ot
Digtit: 2012-11-08 16:11:46 o S R —— e 1=
& SRIBIN 20121025 11:01 AM |2 56 12345 100000 pog Digi]
@ SR1ING 20121101 1:58PM |2 56 12345 100000 b Digt]
20121108 411PM |2 56 12345 100000 b Digt]

Page 12
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6.3 SURVEY DATA

Double-click a survey (date) to see readings and checksums.

] C:\Documents and Settings\ e \My Documents\inclinometer-database.dp =101 x|
= C:\Documents and Settngs \morroe \My Docurme Deoth | AQ |A180 |AChecksm |BO |B 180 | B Checksum 4]
5 Mudteo:INS SuveyDate:  [201210-11 10345 5 _75‘ . . (20 -
Reading Set I‘— = 1 = 1 1 — |
Digtit: 2012-10-18 11:94:13 1 2 |% | [sss |7 9
Digitit: 2012:10-25 11:01:17 Num Passes: 2 15 s & 2 5 2 T
Digtit: 20121101 135810 B [ 1 1 ! ! | !
Digitit: 2012-11-08 16:11:46 o Depi % 2 ‘“ ‘54 | 10 ‘49, ‘-“2 55
@ SRIZIN2 Operator: Pes 25 51 |28 13 408 501 93
# SR12INS —_— — — S—
inst, Constart: ~[100000 3 FZE 2 |55 7
SuveyType:  [Dgok 35 161 176 15 802 852 50 2
SensorSN:  [12385 4 21 |28 |17 7 |-708 n
sy 45 06 |61 s 62 |82 40
8 |7 08 2
sowme [ 5 8 |79 [s 665 |08 5
55 813 a1 0 51 516 102
BasShitA [0 — !
6 245 829 16 27 173 4
BassRB [0
65 7% |7 4 e )
(A s |3 13 ug a7 19
w8 [0 5 535 [543 8 150 197 47
Tansston A [0 8 88 | 2 us |12 2
Tandaton8: [0 85 201|200 1 58 ) 12
Edt New Survey 9 %5 |21 15 u1 |2 )
95 480 |48 ) 4 [a02 39
10 653|646 7 657 leas 11 ¥
< | i | < [ »

6.4 VALIDATE SURVEY
Click on Tools - Validate Survey to see checksum statistics.

Fle Edt Vew Phot | Tools |Profilreader Windows Help

[ e, - L N

C:\Documents and Setti{ o A0 | ACkcdem B0
5 Mudteo:IN5 Expand Spral Survey 5 |5 709
Digtik: 2012-10-18 11:24:13 Ste: [t I— a3 -50 ‘s |68
Digtit: 20121025 11:01:17 R |2 571
Digtit: 20121101 135810 incinometer: [IN5 LA o S 20
. = 54 {-10 497
Digtit: 2012-11-08 16:11:46 Dete/Tme I—ZOHJIH'I 103455 ) )
@ SR18:IN2 1 -38 [13 408
¥ SR18:IN& :, 4
ACheckSum B CheckSum 27 |3 ad e
Mean:  [20 Mean:  [303 L oA e
221 28 17 n?
5. Dev: [170 5. Dev: [360
sos [ s 622
[ B =
ey |ona lo 514
™ e ? | !
5 s (8 |16 27
BasShiB: [0 = 1 1 1
65 799|795 |4 22
Rotation A
0 ¥ 4 703 |19 148
BascrH 75 5% 543 |8 150
Trnsiaton A [0 8 358|356 |2 148
TensastonB [0 85 201|200 Bl 58
_ e | Newsee | b z | s 4
95 80 |49 |9 441
10 653 e 7 557
| — | <

Notes:

e Checksum statistics are an older method for validating surveys. (Plotting checksums is a superior method).
In general, checksum statistics are useful only when compared with statistics generated for other surveys of
the same inclinometer. Large differences indicate a bad survey.

7. GENERATE PLOTS

7.1 OVERVIEW

Profil Manager can generate, print, and export a variety of simple plots. It can also plots as graphic files and export
calculated data to .csv files.

Profil Manager plots are limited to three surveys. Scales and labels can be modified, but cannot be saved for reuse.
Title blocks, annotations, borehole logs, and correction routines are not available.

If you need more advanced features, we recommend that you upgrade to DigiPro 2. A summary of DigiPro 2
features is provided in the appendix.

ROCIEST Page 12 MDA,
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7.2 PLOTTING

Click on an inclinometer, click Plots - Inclinometer, and choose a plot type

File Edit View | Plot | Tools Profilreader Windows Help
| Plot Indinometer 3 Profle Change I | -
£1 C:\Documerts ar Plot Spiral Profile "3
28 Mukilteo: N5 Saved Reports Titt Change
| - Digth. 20Tz TETTIOSE 'ﬁlt Depth | Senorsy | [stument Operator %
Digtit: 2012-10-18 11:24:13 -
- Digtit: 2012-10-25 11:01:17 Checksum % 12345 100000 Peg Dig
- Digtit: 2012-11-01 13:58:10 Difference Chedksum 56 12345 100000 pcg Dig
i - Digtit: 2012-11-08 16:11:46 -
SR1&IN2 Time Plot 56 12345 100000 peg Dig
-SR18:IN4 Horizontal Flots 56 12345 100000 b Dig
Custom Templates 56 12325 100000 b Dig
K | o=

7.3 PROFILE CHANGE

Profil Manager

This is the most common way to present inclinometer data. The plot compares the current profile against the initial
profile. A change in profile is understood to be displacement (movement).

7.4 PROFILE

Mukieo N5 A

Musiteo NS B

1 mzmn g

This is a diagnostic plot that accumulates tilt readings (in mm or inches) to show the profile of the installed casing.

The plot can be used to judge borehole verticality and is also used in diagnostics.

It is also known as an “absolute position” plot because there are no comparisons between surveys.

ROCIEST

Mutstea N5 A

Wukillea N5 B

e80q,,
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7.5 TILT CHANGE

This is a presentation plot that compares the current tilt reading at a given depth against the initial tilt reading at the
same depth. A change in tilt understood to represent displacement.

It is differs from the Profile Change plot in that there is no accumulation of values, so a subsurface displacement is
not represented at the top of the plot.

76 TILT

This is a diagnostic plot that shows tilt in mm or inches at each depth. It can be used to evaluate the installed
“straightness” of the inclinometer.

7.7 CHECKSUM

This is a diagnostic plot that shows the checksum at each depth. A checksum is the algebraic difference between 0
and 180 readings.

Generally speaking, the magnitude of the checksums is less important than the uniformity of checksums within a
survey. In that regard, you would expect to see plots that are straight and vertical rather than curved and off vertical.

ROCIEST Page 15 AR,
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7.8 DIFFERENCE CHECKSUM

This is a diagnostic plot that attempts to remove casing irregularities from the analysis of checksums. The initial
checksum is subtracted from the current checksum.

7.9 SETTINGS

1. Click on the A or B plot to display the settings grid.
2. The settings grid appears.

=k
Lom | owot | 5o | Muhilteo IN5 A Mukilteo IN5 B i
Saltran |n.-,.| Duts | Lot | il 303901 A2 i DH2-H108 el F2 0011 i T2 s 2208 i

Erl= _ iz

Data Scale: Double click to open the grid. Double click “Default-Scale” to change the value to false. Now you can
enter scales. The plot shows changes when you move from each field.

Depth Scale: Double click to open the grid. Double click “Auto-Scale” to change the value to false. Now you can
enter scales.

Labels: Double-click to open the grid. Double click “Default Title” or “Default Labels” to change the values to falsees
to “false.” Now you can enter text for titles and labels.

Adjustments: Double click to open the grid. To show elevations rather than depths, double-click “Display Elevations,’
then adjust values in the Depth scale grid. To invert the reference from bottom to top, double click “Sum-From” to
invert the reference.
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Mukilteo:IN5 Profile_Change

Settings | Surveys | Data | Layout |

P
1. Plot Type
2. Surveys
= 3. Data Scale
Default Scale: True

Title:
Title Font:
Default Labels:

HEHBBMHRB

Notes:

e Profil Manager does not save modified settings.
e Settingsin 1, 2, 5, 8, 9, and Misc are available only in DigiPro 2.

7.10 SURVEYS

Click the “Surveys” tab to select control which surveys are selected for the plot. Profil Manager allows a maximum of
three surveys.

Mukilteo:INS Profile_Change

Print | BExport | Save |

Settings  Surveys |DEna | Layout |

Date / Time v | A Inel | Bxdl | Init
~ amizmon 13560 AN
2012-10:25 11:01-17 [N
20121018 11:24:13 [N
20121011 10:34:55 || W

A (Auto-Select): Profil Manager auto-selects the two most recent surveys. You can exclude a survey to force a
different auto-selection.

Inc (Include): Disabled in Profil Manger.
Exc (Exclude):Profil Manager excludes the checked survey.
Init (Initial): Profil Manger uses the checked survey as the initial for change plots.

7.11 DATA

Click the “Data” tab to display the values used in the plot. Survey dates appear at the top of each column. Use the
scroll bar to see other depths.
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i Mukilteo:INS Profile_Change
Print Export Save

Settngs | Surveys Deta | Layout |

Depth | 201201 | 20121101 | 20121108
35 000 13 321
100 [ 123 318
105 000 13 317
10 000 131 317
15 000 13 317
20 000 [E a1
25y oo 137 321
130 000 135 320
15 000 141 325
140 000 141 326
15 000 141 328
150 [ 140 EES)
155 000 143 325
160 000 143 328
165 [ 142 )
70 000 143 330
175 000 122 S
180 [ 142 332
185 000 206 05
190 000 205 048
195 [ 20 043
20 000 210 045
205 000 o 02
210 [ 22 020

8. PRINT & EXPORT PLOTS

8.1 PRINTING PLOTS

1. Click the “Print” button.

2. Choose “Plots” or “Data.” Click the checkbox for a print preview. Then click OK.

SR18:IN4 Profile_Change

Settirigs | Su * Plots

Zoom'L: F © Data

r meton

Chot Loy _Cancel |

| |
o= Em——

’7 Stack Verical | Stack Honzorial | ‘

8.2 PREVIEW

Print preview lets you inspect the page before you print it. Click the print button to print.

5 - OOEEE o

481,
el

8.3 PAGE LAYOUT
To adjust page margins:

1. Click the “Layout” tab.

2. Click the “Page Setup” button.

3. Adjust margins as required, then click OK.
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Settings | Suveys | Data  Lavor 1
Zoom: [108 =
2
Page Setup 21

Size: 2
Source: | Auto B

Orentation Margins fnches)
@ Porrat Lo i Righi: [0
© Landscape Top: h_aam [1

Cancel Printer

8.4 EXPORTING PLOTS
Profil Manager can export plots as text files or graphic files.

1. Generate the plot.
2. Click the Export button.

¥ Mukilteo:INS Profile_Change
et ] _esen) oo | Mukilten INS A

Settinge IS‘"“‘Q‘*“ | Loyout | a— 2012-10-17 sl I012-11-01 2012-11-08

i

3. The Save-As dialog appears. Choose a file type from the drop menu.

My Computer -
i

.

My Network File name: IF‘rofile_Change :] Save I
Places
Save as type: |Tad Files (" bd} :I foncel I
Text Files (“bd) | 7/

ATLAS Files (".dat)
Image Files (bmp. emf. of . jpa. pna)

Text File: Printable file with tab separated values.

Spreadsheet File: Spreadsheet-ready file with regionalized field separators and decimals.

Atlas File: Data arrays formatted for Atlas. Each array has a date stamp followed by depth-value pairs. A values first,
then B values.

Image File: First select the A or B plot, and then click Export. Choose an image format and click save. PNG and GIF
provide the sharpest results.
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i save Chart x|
—Image Sze —— —Save To
Width  [405 " Clioboard
Height [572 L
i 7
" Printer
Image Fomat Scale Method
" Btmap € Nore
 EMF = ToF
C Gf @ ToPa
 Jpeg o Heigl
* Png T
Save Cancel |
ME

9. Profil Manager vs DigiPro 2

9.1 PROFILE MANAGER

Profil Manager is a utility program supplied at no charge with the Roctest Profil system.

9.2 DIGIPRO 2

DigiPro 2 is a full-featured inclinometer processing program available in 1-seat, 3-seat, or site-license.

Feature Comparison

Profil mansger|  DigiPro 2

Create DPW databases L L

Import dux files from Digitilt AT system .

Import surveys diractly from Digitilt DataMate

Import mdb [DMM/DigiPro 1) databases

Import Gtilt and other file formats

Export surveys data to many formats

Export processed data to tat, csv, dat, and image file

Standard vertical plots L]

wiele|le| e e

Surveys per plot Unlimited

Spacial vertical plots: time plots, resuhtant ploty| L]

Horizontal plots

Copy setfings (scales, etc) btween plats

Mixed plot types, additional plots on page

Title block, annotations, uncertainty-V

Boring Log, Spiral Flot

Corrections for Indlinometer: Crientation, Spiral

Corrections for Surveys: bias shift, rotation, sensitivity
xy translation, settlement

Save plots for reus on new surveys

Save plots as templates for use with other inclinometers

Bias shift Analysis

Rotation Analysis

10. TERMINOLOGY

10.1 INTRODUCTION
Inclinometer terminology has changed over the years, and the Profil system introduces some more changes.
10.2 INSTRUMENT & DATA

Inclinometer Probe: The wheeled sensor that is used to obtain tilt readings. Sometimes it is called a “torpedo” or a
“Probe.”
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Inclinometer: The installed portion of the inclinometer system, sometimes called an “installation,” “borehole,” or
“hole.”

Inclinometer Survey: The readings obtained from two traverses of the inclinometer (by the inclinometer probe). Other
names for surveys are “reading set” and “dataset.”

10.3 FILE EXTENSIONS

dpw: Database file used by Profil Manager and DigiPro 2.

dux: Inclinometer data file used by Profil System.

10.4 PLOT TYPES

Tilt: Previously called Incremental Deviation or Lateral Deviation.
Change in Tilt: Previously called Incremental Displacement.

Profile: Previously called Cumulative Deviation or Absolute Position.

Change in Profile: Previously called Cumulative Displacement.

ROCIEST Page 21 AR,



